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PREFACE

Computer science is an integral part of our lives. In the present world of technology, it involves huge 
interference in the daily work activities including various office procedures, administrative works, travelling 
and even communication also. Therefore its application becomes a valuable subject to be included in any 
training course. The subject provides a good grounding in both the theoretical and practical aspects of 
computer use at workplace.

As part of the JICA project on “Capacity Development for Forest Management and Training Personnel” 
being implemented by the Forest Department, Govt. of West Bengal, these course materials on Computer 
Application have been prepared for induction training of the Foresters and Forest Guards.

The details of Computer Application elucidated in this course material can be suitably adapted by the front 
line forest personnel to improve their efficiency in time management and also ensure the smooth running of 
total administration at their workplace.

The subject covered in these training materials broadly conform to syllabus laid down in the guidelines issued 
by the Ministry of Environment of Forests, Govt. of India, vide the Ministry’s No 3-17/1999-RT dated 
05.03.13.

The contents of the course materials have been prepared and compiled by Project Management Consultant 
Team of IBRAD. While developing this course material, a number  of books, guidelines, literature available 
in the internet have been consulted.

The efforts that have gone into making this course material will be best rewarded if the frontline staff of the 
forest department finds it useful in their day-to-day work.

Kolkata, 2016 

	  	 			 
	

(N K Pandey, IFS)
Principal Chief Conservator of Forests (General), West Bengal                

&                                  
Chairman, State Project Management Unit
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SYLLABUS

Computer Application (24 hours)

1.	 OS Basics of OS (Windows) 4 hours

2.	 Internet Email and Net Browsing 4 hours

3.	 Word Processor MS-Word 8 hours

4.	 Spread Sheet MS-Excel 8 hours
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Lesson Plan

Objective : 

zz To study a basic idea about computer and its peripherals

zz To study the use of computer for word processing, documenting, record keeping of information 
related to forest inventory, growth and yield statistics, forest extent, species diversity etc in soft copy 
with help of MS-Word.

zz To study the procedure of calculation of various required in to accounts work and fund management 
and by using computer with the help of MS-Excel to avoid human error.

zz To learn the use of Computer operating systems to asses extract and work with a large amount of data.

zz To learn Internet accessing and its importance in forest activities.

Total Hours Required :

Lesson Time Alloted
Basics of Computer 	 1 Hour

Operating System 	 1 Hour

Internet 	 2 Hours

Word Processor 	 1 Hour

Spread sheet 	 1 Hour

Practical Classes 	 18 Hours

Methodology/Approach :

zz Brainstorming with few questions

zz Lectures

zz Discussions and interactions

zz Small group discussions

zz Practical sessions
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Session plan

Lesson Session Plan Expected outcome

Basics of Computer l Session 1 
	 	 Overview of Computer
l Session 2
	 	 Types of Computer
l Session 3
	 	 Parts of Computer and their uses
l Session 4
	 	 How to start Computer

At the end of the session the 
participants will gain a basic 
idea about Computer, its 
various peripherals along with 
their uses.

Operating System l Session 1 
	 	 Overview of O.S.
l Session 2
	 	 Function of Operating System
l Session 3
	 	 Types of O.S.
	 n	 Microsoft Windows O.S.
	 n	 Mac O.S.
	 n	 Linux O.S.

At the end of the session the 
participants will learn the 
details of Operating System, 
its different types and the 
procedure of installation of 
OS in computer.

Internet l Session 1 
	 	 Overview of Internet
l Session 2
	 	 Importance of Internet
l Session 3
	 	 How do you connect to the Internet
l Session 4
	 	 How to create Email account 
		  (i.e., Gmail)
l Session 5
	 	 How to send a Email (i.e, Gmail) 

At the end of the session 
the participants will be able 
to access internet, searching 
keywords, sending mail, and 
also contacting other through 
social network.

Word Processor l Session 1 
	 	 Overview of MS-Word
l Session 2
	 	 Importance of MS-Word
l Session 3
	 	 How to Start ?

At the end of the session the 
participants should be create 
a word document which is 
contain text, table , imager 
and font style, also they 
should be able to get their 
document in print.
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Lesson Session Plan Expected outcome

l Session 4
	 	 Basic guidelines for using tools
l Session 5
	 	 Using table in document
l Session 6
	 	 Inserting picture in document
l Session 7
	 	 Printing your document

Spread sheet l Session 1 
	 	 Overview on MS-Excel
l Session 2
	 	 Importance of MS-Excel
l Session 3
	 	 Navigation your MS-Excel work area
l Session 4
	 	 Create a new worksheet
l Session 5
	 	 Entering data
l Session 6
	 	 Formating Data
l Session 7
	 	 Editing Cell
l Session 8
	 	 Creating simple formulas and functions
l Session 9
	 	 Copy and Move data and formulas
l Session 10
	 	 Marge contents and multiple cells 

together
l Session 11
	 	 Prepare a worksheet for printing

At the end of the session the 
participants should be create 
a Excel document and they 
should be able to get their 
document in print.

Practical Classes l Session 1 
	 	 Basic of Computer
l Session 2
	 	 Operating System
l Session 3
	 	 Internet
l Session 4
	 	 Word Processor
l Session 5
	 	 Spread Sheet

In support to the theoretical 
classes, practical classes will 
help the participants to get a 
better idea about the various 
functioning of computer.
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Backward linkage : It is necessary to have basic understanding of computer knowledge, like how to start / 
shutdown computer and how to open file etc.

Forward Linkage : Post training assignment is to be provided with more practical classes that enhance 
knowledge of Computer.

Training Materials required : A Computer for each participant, Kits for Power Points Presentation, and note 
book and pen.
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LESSON-1

Lesson 1

BASICS OF COMPUTER

1.1	 What is a computer?

	 Computer is an electronic device designed to accept data, perform prescribed mathematical and logical 
operation at high speed, and display the result.

1.2	 Types of computers :

	 (i)	 Desktop computer 	

	 (ii)	 Laptop computer 	

	 (iii)	 Tablet computer

Desktop Computer Laptop Computer Tablet Computer

1.3	 Parts of computer :

There are five parts in computer mentioned below.

	 (a)	 Monitor

	 (b)	 Keyboard

	 (c)	 Mouse

	 (d)	 CPU

	 (e)	 UPS

	 (a)	 Monitor :

		  Monitor, are the main output device of a computer. It forms images from tiny dots, called pixels  
that are arranged in a rectangular form. The sharpness of the image depends upon the number of 
pixels.
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		  There are three types of computer monitors :

	 i.	 CRT

	 ii.	 LCD & LED

CRT Monitor LCD & LED Monitor

	 (b)	 Keyboard :

		  Keyboard is the most common and very popular input device which helps in inputting data to the 
computer. The layout  of the keyboard is like that of traditional typewriter, although there are some 
additional keys provided for performing additional functions.

		  Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 108 keys 
are also available for Windows and Internet.

MouseKeyboard

	 (c)	 Mouse :

		  Mouse is most popular pointing device. It is a very famous cursor-control device having a small palm 
size box with a round ball at its base which senses the movement of mouse and sends corresponding 
signals to CPU when the mouse buttons are  pressed.

		  Generally it has two buttons called left and right button and a wheel is present between the buttons. 
Mouse can be used to control the position of cursor on screen, but it cannot be used to enter text into  
the computer	  
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	 (d)	 CPU (Central Processing Unit):

	 1.	 CPU is considered as the brain of the computer.

	 2.	 CPU performs all types of data processing operations

	 3.	 It controls the operation of all parts of computer

CPU (Central Processing Unit) UPS (Uninterrupted power supply) 	
 

	 (e)	 UPS (Uninterrupted power supply) :

		  An uninterruptible power supply, or battery is an electrical apparatus that provides emergency 
power to a load when the input power source, typically mains power fails.

		  A UPS is typically used to protect hardware such as computer, data center telecommunication 
equipment or other electrical equipment where an unexpected power disruption could cause injuries, 
fatalities, serious business disruption or data loss.	

1.3	 How to start a computer ? 

Step 1 :

	 	 Make sure all the cords of the monitor, CPU, Keyboard, and mouse are connected in the	 right 
place.
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Step 2 :

	 	 Plug the power cords of the monitor and CPU to the UPS.

 

Step 3 :

	 	 Switch on the UPS
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Step 4 :

	 	Switch on the computer.

Step 5 :

	 	 Switch on the monitor
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Lesson 2

OS (Operating System)

2.1.	 OS (Operating System) :

	 An operating system is the most important software that run on a computer. It manages the computer’s 
memory, processes, and all of its software and hardware.

	 It also allows you to communicate with the computer without knowing how to speak the computer’s 
language. Without an operating system, a computer is useless.

2.2.	 The operating system’s job

	 Your computer’s operating system manages all of the software and hardware on the computer. Most of 
the time, there are many different computer program running at the same time, and they all need to 
access your computer’s central processing unit   , memory, and storage.

	 The operating system coordinates all of this to make sure each program gets what it needs.

2.3 	 Types of Operating System :

	 The three most common operating system for personal computers are Microsoft WINDOWS, Apple 
Mac X, and Linux.

	 Each operating system Graphics User Interface has a different look and feel, so if you switch to a dif-
ferent operating system are designed to be easy to use, and most of the basic principles are the same.

	 (i)	 Microsoft Windows Graphics User Interface :

 	 Microsoft Windows (O.S.)

	 Microsoft created the windows operating system in the mid -1980s. Over the years, there have been 
many different versions of Windows, but the most recent ones are Windows 8 (released in 2012), 
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Windows 7 (2009), and Windows Vista (2007). Windows comes preloaded on most new PCs, which 
helps to make it the most popular operating system in the world.

	 (ii)	 Apple Mac X, Graphics User Interface :

	 Mac X (O.S.)

	 Mac X (O.S.) is a line of operating system created by Apple. It comes preloaded on all new Macintosh 
computer, or Mac. All of the recent versions are known as OS X, and the specific versions include 
Yosemite (2014), Mavericks (2013), Mountain Line (2012), Lion (2011), and Snow Leopard (2009).
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	 According to State Counter Global Stats, Mac OS X user account for 9.5% of the operating system 
market as of September 2014 much lower than the percentage of windows users almost 90% of one 
reason for this is that Apple computer tend to be more expensive.

	 However, many people prefer the look and feel of Mac OS X.

 	(iii) Linux Graphics User Interface :

	 Linux (O.S.)

	 Linux is a family of open-source operating system, which means they can be modified and distributed 
by anyone around the world. This is different from Windows which  can only be modified by the com-
pany that owns it (Microsoft). The advantage of  Linux are that it is free, and there are many different 
distributions. The most popular Linux version are Ubuntu, Mint, and Fedora.

	 According to State Counter Global Stats, Linux user account for less than 2% of the operating system 
market. However, most servers run Linux because it’s relatively easy to customize.
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LESSON-3

Lesson 3

INTERNET

3.1	 Introduction :

	 The internet is a vast, ever changing medium-some would say the most powerful tool ever created.

	 The internet is a way to share and express information and ideas in a simple way that is accessible to 
nearly 2.2 billion people all over the world.

3.2	 What is internet?

	 The internet is a massive “network of networks”, a networking infrastructure. It connects millions of 
computers together globally. The computer you are sitting at can communicate with the computer 
across the street, down the block, or even around the world so long as the computer on the other end 
is connected to the internet as well.

3.3	 What is the internet used for?

	 A lot of different things people use the internet to apply for job, play games, do research, watch mov-
ies, listen to music stay in contact with friend, family, and co-worker, run a small business, exchange 
information, buy or sell products, and much more.

3.4	 Importance of Internet

	 The Internet has had an enormous impact on education, streamlining access to information and making 
it easier for individuals to engage in online learning. Distance education  programs make it easier for 
students from a variety of backgrounds to attend classes  remotely, cutting down the need for travel 
and reducing the resources required for education. The Internet has also made access to information 
and communication far easier. Rather than searching the library, users can access vast amounts of infor-
mation from home computers. Internet access has a huge impact on businesses, allowing employees to 
work remotely from home and communicate more efficiently. Healthcare is another field greatly affect-
ed by the advent of the Internet. Improvements in online connectivity and communication technology 
allow physicians much greater access to medical resources. Doctors in rural areas can also  use the 
Internet to communicate with experts all over the world, improving the quality of patients’ diagnoses 
and treatments.

	 Politics and government are another area in which the Internet is important. Government organizations 
use the Internet to improve organization and communication, and voters can go online to gain more 
information about current issues. According to Web Junction, 54 percent of adults went online to get 
information about the 2010 U.S. midterm elections. 
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3.5 	 How do you connect to the internet?

	 There are many different way to connect to the internet from your personal computer the most popular 
ways are listed below.

zz  Dial-up : with a dial-up connection, the internet user can connect to the internet via Telephone 
line and an internet service provider (ISP). This method is inexpensive, yet obsolete. It provides the 
user with the slowest overall connection speed. However, it may suit the purposes of the occasional 
internet user without a need for a fast or consistent connection.

zz Broadband : cableand DSL are in this category. With a cable connection, the user must subscribe 
to a cable –television /internet service. These connections offer speeds up to 70  time faster than 
dial-up. They also allow the user to stay connected to the internet at all times.

zz Wi-Fi : It’s even possible to connect to the internet wirelessly from home or while you are out and 
about. Wireless technology allows users to have mobile connections, accessing the web where and 
when they need to Wi-Fi network can be found at many businesses, restaurant, and public area 
(parks, schools, libraries) or a home connection can be set up through your ISP. These technology 
vary in terms of connectivity, reliability and cost, but they all allow users to connect whether they 
are at home school, work or on the road.

	 A web browser is the computer program you use to retrieve and view webpages. On most computers, 
including those at the library, the browser you will use is called Internet Explorer (IE).

Internet Explorer Safari OperaFirefox              Google Chrome

	 There are dozens of other web browsers (Firefox, Google Chrome, safari, & Opera are some of the most 
popular). They may look different, but same basic elements will be there and they all take you to the 
same place the internet.

3.6	 Opening up the browser : 

	 One thing you will notice about the computer as you become more comfortable with it-there are usu-
ally at least three way to do everything. For example, on most computers there will be an icon on the 
desktop for your internet browser. Typically it will be the brand name of the browser for example the 
icon will usually say “Internet Explorer ”.
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	 (i)	 By double click on this icon, you browser should automatically open up and take you to your 
home page. The home page is the first webpage that is displayed when you open your internet 
browser. If you don’t see the icon on the desktop for Internet Explorer,

	 (ii)	 try clicking on  the start button on the lower left  corner of the screen. Often right there  on the 
start button menu.

	 (iii)	 You will see an option for Internet Explorer. A single click of the mouse will take you   to the 
internet.

	 (iv)	 If you click on the browser option. Sometimes on a home computer you might even  have a little 
logo.

	 (v)	 Next to the start button on your desktop taskbar. If you have IE on your computer, it   will 
probably look like a lowercase blue “e” with a yellow ring around it. this is the  logo for Internet 
Explorer.

	 (vi)	 Clicking on it will open the browser.

[Homepage of browser (IE)] 

3.7	 Basic parts of the browser : 

	 The address bar is where the web address of the page you are currently on is displayed. It’s the white 
bar at the very top of your page. If you want to go to a new website and know the Uniform Resource 
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locator(URL), or web address, of the site you’d like to go to , you can click in the address bar and type 
in the URL followed by the enter button to go directly to that page.

	 There are typically four main parts to a URL or web address. Lets look at the example below

http://www.gmail.com

	 (a)	 The http:// stands for Hypertext Transfer Protocol. This help your web browser locate the webpage or 
website, and to display it for you to see. Most browsers will automatically add this prefix, so you don’t 
have to worry about typing it every time.

	 (b)	 The www stands for World Wide Web. This means that the page you’re looking for is somewhere on 
the World Wide Web. For some websites, it’s not even necessary to type in the “WWW” part.

	 (c)	 The next section, which is “gmail” in this example, is the name of the webpage or website. It is flanked 
by dot (.) on either side which separate it from other sections of the web address.

	 (d)	 The .com here is the top level domain name. this tells you where the webpages is registered and often 
tells you what kind of website that it is. For instance , .com usually means that you’re looking at a 
commercial site, or a site that some has paid to us. Some other common domain names are.

		  .edu (sites for educational institute)

		  .org  (sites belonging to organizations)

		  .gov (sites sponsored by local, state, or federal governments).

3.8.	 Email :

	 Short for electronic mail, email   (or e-mail)   is   defined as the   transmission    of    messages   over 
communications networks. Typically the messages are notes entered from the keyboard or electronic 
files stored on disk. Most mainframes, minicomputers, and computer networks have an email system.
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	 Some electronic mail systems are confined to a  single computer  system or  network,  but  others  have 
gateways to other computer systems, enabling users to send electronic mail anywhere in the world. 
Companies that are fully computerized make extensive use of e-mail because it is fast, flexible, and 
reliable.

zz Here some popular email service provider is : Gmail, Yahoo, AOL, Hotmail etc.

zz Follow these step-by-step instructions to create a Gmail account

	 Step 1 : Open up your internet browser and go the Google home page : http://www.google.co.uk.

	 Step 2 : Click on Gmail at the top right corner of the page.

	 Step 3 : You’ll now be in the “Sign in section”. As you don’t have a Google account yet, you need to 
create one. Click Create an account.

	 Step 4 : To set up your new account, Google needs some information about you – first, your first and 
last names. The “choose your username” is the unique email address that you wish to use, which will be 
placed before “@gmail.com”. Because it needs to be unique, Google may have to check the availability 
of any name that you decide on to make sure that no one already has it. Type an email name into the 
“choose your username” box and then fill out the rest of your information. You will need to ensure that 
the “I agree to the Google terms of service and Privacy Policy” is ticked. Then click next step.

	 Step 5 : If the email name that you requested in is not available, you’ll get a message saying that 
somebody already has that username and offering you some alternatives. You can decide to accept 
one of the alternatives or type in another name and check its availability once more. You will have to 
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complete some of the other boxes again. You may have to do this a few times. Once you finalise your 
email address, it’s a good idea to make a note of it so that you can refer to it until you remember it.

 

Step 6 : You’ll need to come up with a password so that you can log in securely to your account. Google 
may explain that you should try one with at least 8 characters long to be secure. Use letters and numbers
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to make the password more secure and difficult to guess. You’ll need to re-enter your password to ensure 
that it’s you choosing it and not a hacker’s (ro)bot. This is why it also asks you to insert two random 
words at the bottom of the page – this is a CAPTCHA code. You can skip this step if you don’t want 
to type in the CAPTCHA code but you will need to verify via a mobile phone if you don’t.

Step 7 : Once you have completed this page fully, clicking Next Step will take you to the Create Profile 
Page. If you don’t wish to have a picture on the web, click Next Step to complete setting up your email. 
If you do, Click on Add Profile Photo and find a photo to add. Then click Next Step.



16 MANNUAL FOR COMPUTER APPLICATION

Step 8 : You will now have set up your account. You can go straight to your inbox and get started, or 
you can set up a photo to show as your profile picture.

Click on Add a photo to upload a photo and select a photo.

Or click on Next Step to go to your inbox and get started.

3.9 How to send mail to other :

Step 1 : Login into your gmail account using your user ID and Password. After click on	 login button 
the below screen will appear.
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Step 2 :  Click on COMPOSE button

3 
Go to the To : box. In the To : box type in the email address of the person you would like to send an 
email to. If there are multiple people you want to send it to, click on the Add

Cc and Add Bcc buttons.
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4 

Type the email subject : The subject lets people know what the email is going to be about. 

5 

Type your message in the big box below the subject box. 
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6 

Click the send bottom below the message box.

zz Wait until the person you sent the email replies.

7 

Have fun sending lots of emails to all of your friends !

Include a Document or File in Your Email

LESSON-3
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1 

Look under the Subject box : You should find a link that says Attach a File. Click this.

2 

It will take you to files on your computer. 
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Lesson 4

WORD PROCESSOR

4.1	 Word processing

	 Word processing is an application where a document is created, edited, and printed by using a computer. 
Of all computer applications, word processing is the most common. To perform word processing, you 
need a computer, a special program called a word processor, and a printer. A word processor enables 
you to create a document, store it electronically on a disk, display it on a screen, modify it by entering 
commands and characters from the keyboard, and print it on a printer.

4.2	 What is MS-Word ?

	 MS-Word or Microsoft Word is a computer program. Computer is an electronic toolbox for working 
with information. The tools inside the toolbox are called programs.Different programs can be useful for 
creating different kinds of documents. The program MS-Word is very useful for creating text documents, 
from a simple letter to a complete book with pictures.

	 Examples of simple text documents are letters, leaflets, timetables, pricelists, questionnaires, examina-
tions, These documents are usually only one or two pages in size and are quite easy to create. With this 
part of Computers you will learn the basic functions to create any simple document.

	 Examples of complex text documents are project proposals, reports, books, etc. Such documents consist 
of many pages and require page numbers, chapters and paragraphs, a table of contents, etc. MS Word 

LESSON-4
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also provides these functions. Just start and find out later as you go along Look through the menu’s,  
click on buttons and  see  what happens.  There is nothing you  can  do wrong, that you cannot ‘Undo’ 

with a few clicks.

	 That is enough to create professional documents like this letter, sched-
ule and leaflet :

	 4.3  What is the importance of MS-Word ?

	 In the past, desktop processing software was complex. Most programs 
separated the content of the document from its formatting, which 
made creating the document a two-step process. Microsoft Word was 
one of the first programs to combine text processing and formatting, 
and its early popularity endures today.

	 The Microsoft Word document format is complex, and many believe 
that it was created to be difficult to implement in other programs. 
Even though Microsoft has moved to a newer file format, compatibility 
issues still remain. Because of this, some governments are mandating 

that documents be created with other file formats.

	 Even the business world is slowly moving away form Microsoft Word files. HTML can provide much of 
the same formatting that Word provides, and it makes files easier to read over the Internet. The PDF file 
format is becoming more popular for printed documents. While creating a PDF file is more challenging 
than creating a file with Microsoft Word, the file format is designed specifically for printing and gives 
authors more options. Despite these changes, Microsoft Word is likely to remain the most popular word 
processor.

4.4	 Getting started :

	 Before starting your first document, do the following :

	 1.	 Create a folder for yourself in ‘My documents’
	 2.	 Start the program called ‘MS-Word’
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	 3.	 Save the new document in your folder and remember to save frequently while you work.

	 4.	 Turn this page and take a good look at the letter you are about to create.

4.5	 Where to start ?

	 You looked at the Letter and nowyou want to make one yourself . Start by typing all the text: the 
address, the date, etc. Only type the text and use the Enter-key to type on a new line. When you finish 
typing, all text is atthe left of the page, including the date. Then go through Step to Step change the 
letter’s appearance.

	 You need basic functions of word the picture shows that what function you need for what step.

 	    Just try and use ‘Undo’ if you make a mistake.
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Using Tabs to create spaces

	 1.	 Click the cursor in front of the first word : ‘Kilisports’

	 2.	 Press the Tab-key on your keyboard two times 

	 3.	 Put the cursor in front of ‘Mr. David Long’

	 4.	 Press the Tab-key on your keyboard twice 

	 5.	 Repeat this for ‘PO Box’ and ‘Arusha’

Creating a list

First type and select the text lines you want in your list :

	 1.	 Click in front of the first line and hold the mouse button 
down.

	 2.	 Drag the cursor down to select all text and release the 
button.

To make a list with ‘Bullets’ :

	 1.	 Move the cursor to the ‘Bullets’-button: a label appears  
‘Bullets’

	 2.	 Click the button and click on the page to un-select the  
text.

To make a list with numbers :

	 1.	 Select the text and click the button ‘Numbering’

Making text bold, underlined & Italic.

	To change the appearance or ‘format’ of text :

	 1.	 Select the text and click the button ‘B’ to make the 
text Bold.    

	 2.	 Click on the page to un-select the text

	 1.	 Select the text and click the button ‘U’ text Underlined

	 2.	 Click both buttons to make the text Bold and Underlined

To make text beng to the right

	 1.	 Select the text and click the button ‘I’ to make the text  
Italic.

 Part 2  Part 2
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Changing the Font and Font Siz : 

To make text smaller or bigger :

	 1.	 Select the text and click on the arrow next to the size : ‘12’

	 2.	 In the list that appears, go to ‘14’ and click: the text is bigger

To change different text format :

	 1.	 Select the text and click next to the name of the font: ‘Times’

	 2.	 In the list that appears, select ‘Arial Black’

Aligning text Right and Center :

To pur text on the right side of the page :

	 1.	 Click the cursor in the text or select the text

	 2.	 Press the button ‘Align Right’

To put text in the centre of the page :

	 1.	 Select the text and click the button ‘Align Center’

	 2.	 Click the button ‘Align Left’ to put the text back to normal

Changing Left and Right Margin :

To adjust the amount of white space left and right on the page. 

	 1.	 Move the cursor to the left margin on the top ruler

	 2.	 2. Wait until the cursor changes shape and ‘Left Margin’ 
appears

	 3.	 Click and hold down the left mouse button

	 4.	 Slowly move the mouse to the left or right and release

	 5.	 Repeat this for the right margin on the right  side  of the top

Changing Top and Bottom Margin :

To adjust the amount of white space on the top and at the bottom of the page.

	 1.	 Move the cursor to the top margin on the left ruler 
	 2.	 Wait until the cursor changes shape and ‘Top Margin’  

appears
	 3.	 Click and hold down the left mouse button
	 4.	 Slowly move the mouse up or down and release

	 5.	 Repeat this for the bottom margin on the lower side of the ruler
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4.6 	 Using tables in your document

	 To insert a table into your document :

	 1.	 Click the cursor on your page where you want the table

	2.	 Click and hold down the button ‘Insert Table’

	3.	 Drag the cursor; see that the text specifies the size of   the 
table.

	4.	 Choose the right size and release the button to insert the 
table.

For a table with 16 rows and 6 columns (‘16 x 6 Tab le’) :

	 1.	 Hold the button down and drag until you read : ‘16 x 6 Table’

	 2.	 Release the mouse button to insert the table

To put text into a table :

	 1.	 Click the cursor inside a cell and start typing as usual.

To put text into another cell :

Click the cursor inside the new cell and start typing
	 1.	 Or Use the Tab-key for going to the next cell

	 2.	 Use the “Cursor”-keys to move from cell to cell

To change the format of text in a cell, first select the text :

	 1.	 Select the text or click 3 times in the cell

	 2.	 Now you can change the format: Font, Font Size

To put text on the right side, first select the text or column :

	 1.	 Put your cursor in one cell and drag down to select more cells

	 2.	 Now you can use the buttons “Align Right” or “Align Center”

Changing border lines

	 1.	 Select one cell or a whole column (Choose “Select Column” in the Table-menu)

	 2.	 Press the small arrow next to the button “Outside  Border”: A new menu appears.

	 3.	 In the menu that appears, choose the button “No borders”.

	 4.	 Try other buttons in the menu to create the look you want.
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Changing cell and column size

	 1.	 Move the cursor on a border and wait until it changes shape

	 2.	 Click and drag until the cell is the size you want and release

Merging cells

	 1.	 Select cells or a row (Choose “Select Row” in the Table-menu)

	 2.	 Choose “Merge Cells” in the Table-menu

Adding and deleting cells

	 1.	 Select a column (or row) 

	 2.	 From the Table-menu choose “Insert Column” (or Delete) The same goes for rows!

INSERTING PICTURES

To put a picture in your document :

	 1.	 Put the cursor where you want the picture

	 2.	 From the Insert-menu, choose “Picture” and “From File”

	 3.	 Select a picture and click the “Insert” button

To put symbols in your text :

	 1.	 Put the cursor in the text where you want the symbol

	 2.	 From the Insert-menu, choose„ Symbol…

	 3.	 In the dialogue, click on a symbol to see it bigger or 
move through the symbols with the cursor-keys

	 4.	 Click the “Insert” button and then the “Close” button

Changing the size of pictures :

	 1.	 Click  on  the  picture  to  select  it : the 
“handles” appear

	 2.	 Put your cursor on one of the “handles” 
until it changes shape.

	 3.	 Click and drag the handle until the picture 
is the size you want
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Drawing lines and circles :

	 1.	 Click on the “Line”-button on the bottom of your 
screen

	 2.	 Click and hold to drag a line on the page where you 
want it

	 3.	 Use the “Line Style”-button to make the line thicker 
orthinner.

	 4.	 Try out other buttons and draw circles, rectangles and 
arrows

Changing colors of objects and text : 

	 1.	 Draw a circle or rectangle and select it

	 2.	 Click the arrow next to the “Fill Color”- 
button

	 3.	 In the color-menu, click on a color to change the circle’s color.

Creating special text effects :

	 1.	 Click   the„  “Word  Art”-button

	 2.	 In the dialogue that appears, choose a style and click “OK”
	 3.	 In the window that appears, type your text and click “OK” 
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Printing your document

After creating a document, use a printer to put it on paper. Use the ‘Print Preview’ function to see on 
screen how the document will look when it is printed. If you are not satisfied, you make some changes 
and ‘Preview’ again. This function will save you a lot of paper and ink!

Open word file which you want to print.

	Step 1 : click on “File” this should be located towards top of the windows.

Step 2 : click on “Print” this will bring up the printing menu.
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Step 3 : finally click on print button, and you will get it on paper form printer.
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Lesson 5

Spreadsheet 

Introduction to MS-Excel

5.1	 Spreadsheet

A spreadsheet is a table of values arranged in rows and columns. each value can have a predefined rela-
tionship to the other values. If you change one value, therefore, you may need to change other values 
as well.

MS-Excel Sample Screenshot
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5.2	 MS-Excel

Microsoft Excel has the basic features of all spreadsheets, using a grid of cells arranged in numbered rows 
and letter-named columns to organize data manipulations like arithmetic operations. It has a battery of 
supplied functions to answer statistical, engineering and financial needs. In addition, it can display data 
as line graphs, histograms and charts, and with a very limited three-dimensional graphical display. It 
allows sectioning of data to view its dependencies  on  various  factors  for  different  perspectives.  It  
has  a  programming  aspect, Visual Basic for Applications, allowing the user to employ a wide variety 
of  numerical methods, for example, for solving  differential  equations  of  mathematical  physics, and 
then reporting the results back to the spreadsheet. It also has a variety of interactive features allowing 
user interfaces that can completely hide the spreadsheet from the user, so the spreadsheet presents itself 
as a  so-called application,  or Decision  Support  System (DSS), via a custom-designed user interface, 
for example, a stock analyzer, or in general, as a design tool that asks the user questions and provides 
answers and reports. In a more elaborate realization, an Excel application can automatically poll external 
databases and measuring instruments using an update schedule, analyze the results, make a Word report 
or Power Point slide show, and e-mail these presentations on a regular basis to a list of participants.

Importance of MS-Excel

Accounting and Finance
Excel is often used in accounting and finance because of its ability to automate calculations and its sup-
port for complex formulas. Excel spreadsheets can calculate the accrual of compound interest and net 
income after adjusting the gross for expenses, for example. Once formulas have been entered in a table, 
you simply plug in numbers where necessary and  Excel does the rest, populating cells with the results 
of the calculations. This makes Excel an indispensable tool for business accounting.

Data Organization
Even non-financial businesses employ Excel spreadsheets. The ability to organize data in Excel tables 
and set up tools for updating, organizing, and displaying the data makes the program popular for 
administrative purposes. Comprehensive, easy-to-reference Excel tables allow administrators to check a 
single statistic in a process, such as service fault issues in a product, against a report of trends for the 
same service faults. Through these comparisons, issues can be identified and solutions developed.

Graphing
Excel also produces a variety of charts and graphs for representing income statements and other statis-
tical data visually. You save time by making the charts in the spreadsheet where the data resides. Visual 
presentation of the data drives home your points more effectively  than columns of numbers. Being able 
to graph within Excel also frees up some capital that otherwise would have to be invested in another 
graphing program. 
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Using Your MS-Excel Work Area

Using toolbars

Menu choices and icons mean the same thing throughout all Microsoft products (Word, PowerPoint, etc.).

zz For example, the Save icon will always be depicted by a graphic of a disk, and the Print icon will 
be depicted by a printer.

	 The Main Menu provides a variety of tabs : Home, Insert, Page Layout, Formulas, Data, Review, and View.

zz The Office button includes icons for common functions such as new document, saving 
or printing a file.

zz The Home tab is where you can find icons for changing font appearance, for example :

	 	 Type of font
	 		 Special font features such as bold, italicize or underline
	 	 Formatting for paragraph or number (alignment, indentions, number of decimals to display, etc.)

zz The Quick Access toolbar give you access to frequently used functions such as save, undo and redo 
no matter what tab you are using.

Navigation Cells within a worksheet
In MS-Excel, the primary document where you store and work with data is referred to as a worksheet. It 
is also known as a spreadsheet. A worksheet is made up of various horizontal rows and vertical columns.  
Each row and column contains many cells.

Each white box within the spreadsheet is a cell. The row 
and column in which a particular cell is located is referred 
to as the cell address. MS-Excel provides many methods for 
moving around the worksheet; here are three of the more 
commonly used methods.  Please  try  each  of  the  methods  
by  following  all  directions below.
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Method 1 : Click on a specific cell

	 1.	 Click on cell B12 (Column B, Row 12).

		  When you click on B12, the Name Box displays the cell address in the upper left corner of the work-
sheet, and the row and column titles are highlighted.

	 2.	 Type your name in cell B12.
		  As you add contents into the cell, the cell contents display in the Formula Bar, which is located  

directly above the worksheet.

	 3.	 Press Enter.

�� Note :  how the cursor now moves to the following row of the worksheet.
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Method 2 : Use arrow keys to move to the next cell

	 1.	 Using the arrow keys on your keyboard, move to cell C15.

Method 3 : Enter the cell address in the Name Box

The Name Box displays the cell reference of the active cell (format: column letter, followed by the row 
number, e.g., B12).

	 1.	 Click inside the Name Box.
		  The current cell name (C15) will be highlighted.

	 2.	 Type B12 into the Name Box.
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	 3.	 Press Enter.

You should notice your cursor jump 
from cell C15 back to B12, the location 
you specified in the Name Box. Cell 
address (or cell name) is always listed 
with the column letter followed by the 
row number.

Creating a Worksheet
As previously mentioned, the main work area of MS Excel is called a worksheet. You can create a new 
worksheet to store information, or to add on to an existing worksheet.



37MANNUAL FOR COMPUTER APPLICATION

LESSON-5

Creating a New Worksheet	
You can create a new worksheet either by using the Insert Worksheet button at the bottom of the screen 
or by right clicking.

Using the Insert Worksheet button

	 1.	 Click the Insert Worksheet button. 

			 
	 2.	 A new worksheet will display.

			 
Right-clicking :

	 1.	 On your current worksheet tab, right-click.

	 2.	 Select Insert from the menu.
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	 3.	 Choose Worksheet. 

	 4.	 A new worksheet will display.

Renaming a Worksheet
If you want to specify a name for your worksheet other than “Sheet --”, 
use the rename feature to change the worksheet title to a name that is  
easily identifiable. To rename a work-
sheet :

	 1.	 Right click on the worksheet tab 
located on the lower left corner of 
your screen.

	 2.	 Select Rename.

		  The current worksheet name will 
display highlighted.
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	 3.	 Type the name of the new worksheet directly in the tab.

Entering Data

MS-Excel allows you to enter data, both numerical and text, into the cells which make up the rows or 
columns of a spreadsheet. You can enter data in one cell or in several cells at the same time. In this 
section we will learn how to enter data, and format and edit the data we have entered. Lets explore 
how to enter data.

	 1.	 We enter the following numbers into cells D5-D9 : 5, 2, 3, 2, 1

 	 2.	 Next, in cell D4, we enter the title Numbers formatted in bold and italics, by typing the word into 
the cell, highlighting the word or selecting the cell the word is in, and clicking on the Bold and Italics 
buttons on the Home tab.
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Now that you have entered data, we can now assign unique identification (ID) numbers to cells  
D5-D9. We can do this by either typing numbers in manually or by using the auto fill feature, some-
times referred to as the drag and drop method. Use the auto fill feature to fill cells with data that follow 
a pattern (e.g., consecutive numbers, odd and even numbers, months).

Let’s see how this works in column C of the current worksheet by assigning an ID number for each 
row in your Numbers column.

Auto Fill/Drag and drop method

	 1.	 Enter the title ID into cell C4, using bold and italics (Reminder : The Bold and Italics buttons can be 
found on the Home tab).
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	 2.	 Next enter the number “1” into C5 and number “2” into C6. This will define and establish the 
pattern, which is to number each row consecutively starting from 1.

	 3.	 Highlight the two numbers entered into cells C5 and C6.Start by clicking on the first cell, C5; the 
cell will be outlined in black and a thick plus sign should display.

                                          

		  If the plus sign does not display, move the mouse over the cell until it does. When it displays, hold 
down the left button of the mouse and drag the cursor down to cell C6.

	 4.	 Next, move the mouse over the small square in the bottom right corner of the selected cells until you 
see a thin black plus sign.
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	 5.	 When you see the thin black plus sign, click and hold the left button of your mouse and drag the 
selection to all of the cells that still need to be numbered consecutively, in this case C7, C8, C9.

		  The cells will display highlighted in a grey patterned box.

	 6.	 Release the mouse button, to generate or drop the pattern into place.

	 7.	 Check to make sure your pattern copied correctly. If it did, cells C7-C9 will show the following con-
secutive numbers: 3, 4, and 5.

Formatting Data
MS-Excel provides a simple way to change the appearance and layout, or format, of your spreadsheet 
and the data within it. To format cells in MS-Excel, use the Format Cells menu.
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Using right-click

	 1.	 Select the cells you would like to format.

	 2.	 Right-click, and select Format Cells from the menu.

		  Selecting Format Cells brings up a box which contains various tabs.
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		  Tabs offer various functions and formatting options related to Number, Alignment, Font, Border,  
Fill, and Protection.

		  Many of these same features are also available on the Home tab at the top of your screen.

 	 Accessing the Format Cells box simply allows you to see all of the options in one location.

Font

Lets see how it works by changing the column titles Font to Consolas, changing the Font Style from bold 
italics to bold only and then underlining the titles.

	 1.	 Highlight the cells you want to format.

	 2.	 Access the Format Cells box and click the Font tab.

		  It shows the current format which is : 

		  Font : Arial

		  Font style : Bold Italic

		  Underline : None
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	 3.	 To change the font formatting :

	 a.	 From Arial to Consolas : Click on the down arrow on the scroll bar of the Font menu until you 
locate Consolas. Be sure to select it from the menu.

	 b.	 From Bold Italic to Bold :  Select Bold from the Font Style menu.

	 c.	 From no underline to underline: Select Single from the Underline drop-down menu.

�� Note : That you can also change the font color, size and other font effects.
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	 4.	 Once you have selected all these options, click the OK button.

		  Here’s how it looks.

Alignment

Next, we’ll explore the Alignment tab, which affects the position of numbers or text within the cell.

	 1.	 Highlight the cells we want to format (cells D5-D9).

	 2.	 Using either right-click or the Format menu, access the Format Cells box.
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	 3.	 Click the Alignment tab.
	 4.	 From the drop-down menu under Horizontal, choose Center.

�� Note :	 That you can also adjust the vertical alignment and merge multiple cells together in the Alignment 
tab.

Numbers

Now let’s take a quick look at how the Numbers tab in the Format Cells box works by changing the 
number of decimal places for the values in our Numbers column.

	 1.	 Highlight the cells we want to format (cells D5-D9).
	 2.	 Using either right-click or the Format menu, access the Format Cells box.

	 3.	 Click the Number tab.
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Notice the multiple categories available to you in the Category list. When you have a moment you should 
familiarize yourself with the other options in the Category list.

	 4.	 From the Category list we select Number. In Decimal Places, we change the number to 2 either by 
entering the number manually or using the scroll bar to manipulate the numbers.
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	 5.	 Once you have selected all these options, click the OK button. Here’s how it looks.

Editing Cells
Once you have entered data into a cell, you may want to edit it. There are several ways that you can 
edit data in MS-Excel. Here are two :

	 1.	 Double click on the cell to make edits directly in the worksheet, or

	 2.	 Click on the cell and then make changes in the Formula bar.

Now that you have entered information in your worksheet, it is important to save it. To Save a file, you 
can either click on the Office button at the top of your screen and select Save, OR you can click 
on the Save button on the Quick Access menu.

Creating a Simple Database

Now that you know how to enter and edit data in an MS-Excel Worksheet, you can create a database. A 
database is simply a file that stores data so that it can be analyzed later. You will often hear this referred 
to as a “dataset” in public health settings.

MS-Excel is a great data management package for beginners. Other more advanced options exist for larger 
amounts of data and/or advanced statistical analysis, such as SAS, STATA, SPSS, or Epi Info. If later on 
you become proficient in one of these programs, the good news is that even if you created your database 
in MS-Excel, you can upload the file to any of these advanced statistics packages to run your analysis.
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The key points for creating a database are as follows :

zz Each column represents a variable.

�� Be sure to add a descriptive title for each variable (e.g., ID, name, sex, age, race, disease 
status, exposure status).

�� Always include units (if applicable).

�� Be sure to include a column for a unique identification (ID) number for each row in your 
database.

zz Each row represents a separate record or person in your database.

zz Enter all data for each record before moving on to the next one.

�� Leave cells with missing data completely empty. Do not enter “0,” “unknown” or “none” for 
missing data.

�� Be sure that each record has a unique ID number that ties the data to its original file.

�� For variables with character data (i.e., not numbers), use the same format when recording 
this data in the database.

For example, patient blood types A, B, A/B, or O could be recorded by assigning numeric values to each 
type (0=A, 1=B, 2=A/B, and 3=O), or using the same spelling, symbols, and pattern of upper/lower case 
letters when you enter the text.

zz Make variables with many possible formats standardized (e.g., all dates should be formatted as 
01/01/11, all numbers should be formatted to two decimal places, 0.00).

zz Before beginning analysis, check and clean your database for errors and inconsistencies.

zz Always save new copies of the database with a new name each time you make changes.

�� This allows you to return to the original data file if necessary and start analysis again.

zz Ask yourself :

�� Did you use a standard format for all fields?

�� Are any fields missing data that are provided in the data record?

�� Are there any typos ?

Creating Formulas and Functions

Creating Simple Formulas

Besides storing text or numbers in a cell, you can also store formulas, which will display the result of a 
calculation. MS Excel is useful for simple mathematic operations such as for adding (+), subtracting (-), 
multiplying (*), dividing (/), and exponentiation (^). It can also be used for more complex functions 
such as statistics or finance calculations.
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To create a simple formula, follow the steps below:

	 1.	 Click on the cell where you are placing the formula

	 2.	 Signal that you are creating a formula by typing an equal (=) sign.

	 3.	 Enter your formula by adding numbers or cell addresses and mathematical operators (the symbol or 
sign that represents an arithmetic operation in an MS-Excel spreadsheet formula, i.e. +, -, *, /, ^)

	 4.	 Click Enter, and the numeric value you calculated will display.

Examples

	 1.	 To add cells A1 and A2 together, enter the formula below into an empty cell, by typing an equal sign 
(=), then clicking on cell A1, typing a plus sign (+) and clicking on cell A2 :

= A1 + A2 

	 2.	 To divide the value of E5 by 2, enter the formula below into an empty cell :

	 = E5/2

Practice

Let’s give it a try. Using the sample data file you created, class1.xls, let’s multiply the first two numbers 
in your list.
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	 1.	 Click on the cell where you are placing the formula (an empty cell a few spaces below your column 
of numbers)

	 2.	 Signal that you are creating a formula by typing an equal sign. =
	 3.	 Enter your formula by adding numbers or cell addresses and operators.
		  For this example, use the asterisk to multiply the first two numbers in your list located in cells D5 

and D6.

	 a.	 Type D5 or click on the first cell of the equation (D5)
	 b.	 Insert the multiplication sign*
	 c.	 Type D6 or click on the next cell in your equation (D6) The formula bar should now read  

= D5 * D6
	 4.	 Click Enter, and the numeric value you calculated will display The correct response is 10.

Order of operations
More complex formulas usually include more than one calculation. MS Excel calculates the results of 
complex formulas in the following order. Add parentheses or brackets around part of your formula to 
overcome the natural order of operations.

Order of Operations

Instructions :

	 1.	 Using the current MS Excel worksheet class1.xls,	
		  Enter =D5 + D6 * D7 in the cell beneath the last formula entered.
	 2.	 In the next cell down, enter = (D5 + D6) * D7.
	 3.	 Compare the results of both formulas.
	 4.	 When you have finished, return to the workbook and compare your work in MS-Excel to the 

screenshots below.

In the first formula you entered, the computer will first multiply cells D6 and D7 and then add D5, 
which equals 11. 
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The second formula you entered will first add cells D5 and D6, since they were in in parentheses, and 
then multiply the sum by D7, which equals 21. 

Functions
Functions are simply built-in formulas that can save you time. Some of the most common functions 
are shown below.

�� AVERAGE – takes the arithmetic mean of the cells within its range.

�� COUNTIF – counts the number of times specific criteria are met within its range.

�� MAX – displays the largest value in the cell range.

�� MEDIAN – produces the median of the cells within its range.

�� MIN – displays the smallest value in the cell range.

�� SUM – adds the values of each cell within its range.

There are several ways to access and create these and other functions. Below we review three methods.

Type function in Formula bar

You can simply type the function formula into the Formula bar, as you would with any other formula 
(for example: =SUM(A1:A3))

Let’s practice using the COUNTIF function. For example, if you want to count the number of times 
“2” appears in the Numbers column, select an empty cell and complete the following steps. Do not 
include any spaces in the formula.

	 1.	 Enter the following in the formula bar: = COUNTIF (D5 : D9, “2”)

	 2.	 Highlight the data range you would like to use: = COUNTIF(D5 : D9, “2”)

	 3.	 Type a comma and specify the counting criteria surrounded in quotation marks :	  
		  = COUNTIF (D5 : D9,“2”)
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	 4.	 Close the command with a parenthesis : = COUNTIF(D5:D9,“2”)
	 5.	 Click Enter.

How many cells in the range are equal to the number 2 ?

Click on the Function button   

When you click the Function button, you will see the Insert Function box. You can then find a function 
in two ways :

	 1.	 Type a description of what you want to do and click Go. This is useful if you are not sure of the 
function name.

	 2.	 MS Excel organizes functions into different categories such as Financial, Date & Time, Math & Trig, 
Statistical, etc. You can select a category by clicking on the drop down Category menu.
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Click on the arrow next to the Sum button on the Standard toolbar.

This method shows several common functions like Sum and Average. 

Lets practice using the Sum button.

	 1.	 Click on an empty cell.

	 2.	 Click the ∑ icon (AutoSum button).

�� Note  that MS-Excel suggests the values you want to total by highlighting them with a patterned line

	 3.	 If this is the correct range of numbers that you want to sum, press Enter.

	 4.	 If it is incorrect and you would like use to a different set of numbers, you can resize the dotted line.

Using the double-sided arrow   that displays when you place your cursor on the right hand corner of 
box highlighting the cells, click and hold the mouse button while you move the box around the cells 
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you want included in the calculation.

	 5.	 Once correct, press Enter.

You should also know how to edit formulas or functions. The same two options that we learned to use 
for editing data also apply when you want to change a formula or function.

	 1.	 Double-click a cell to make changes directly in the worksheet.
	 2.	 Click in the cell, and then edit your formula or function in the Formula bar.

Changing Layout and Sorting data

	 There are a number of ways to change the layout of your worksheet in MS-Excel.

Copy and Move Data and Formulas
It is important to understand the difference between copying and moving data. When you copy data, it 
can be pasted multiple times in multiple places. For this reason, the dotted line will display around the 
cell(s) copied until you double click inside another cell. When you move/cut data, the data can only 
be pasted one time and will be permanently removed from its original location. Copying cells with a 
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formula takes that formula and applies it to a different set of cells in addition to its current location. 
You may want to do this if you would like to calculate the mean, median, and mode for one variable 
and then apply the same calculations to other  variables. Cutting a formula takes the formula exactly as 
it is entered in the original cell and moves this entry to a new location.

To copy and paste a single cell

	 1.	 Click on the cell containing the data that you want to copy.

	 2.	 Next, you can copy by either :

	 a.	 Right-clicking and then selecting Copy from the drop-down menu that displays

	 b.	 Holding down the control key (Ctrl) and the letter “C” on your keyboard

	 c.	 Clicking the Copy icon on the Home tab

	 3.	 Notice that a dotted line surrounds the cells that you are copying.

	 4.	 Paste the copied data where you would like it to go by either :

	 a.	 Right-clicking on the desired cell and selecting Paste from the drop- down menu

	 b.	 Holding down Ctrl + V after selecting the desired cell

	 c.	 Clicking the Paste icon on the Home tab

To copy and paste multiple cells

	 1.	 Highlight the cell range that you want to copy.

	 2.	 Copy the cells using any of the methods described above.

	 3.	 Highlight the cell range into which you want to paste. (Note: They must be the same number of cells 
that you copied)

	 4.	 Paste.

Once you have pasted single or multiple cells, press Enter on your keyboard.
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Copying and Pasting Multiple Cells

Instructions :  In your class1.xls file :

	 1.	 Select cells D5-D9.
	 2.	 Copy cells.
	 3.	 Highlight cells H5-H9.
	 4.	 Paste cells.
	 5.	 When you have finished, return to the workbook and compare your work in MS Excel to the 

screenshots below.
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To copy and paste a formula

	 1.	 Select the cell that contains the formula you want
	 2.	 Copy using any of the options described above

Now let’s copy and paste the formula you used to sum up the cells in D5-D9.

Copying and Pasting a Formula

Instructions :  In your class1.xls file:

	 1.	 Select cell D11.
	 2.	 Copy cell.
	 3.	 Select cell H11, just below where you copy and pasted the multiple cells.
	 4.	 Paste.
	 5.	 When you have finished, return to the workbook and compare your work in MS Excel to the screen-

shots below.
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To move data from one cell to another cell

	 1.	 Use the Cut feature by clicking on the cell containing the data that you want to move and then either:

	 a.	 Right-click and select Cut from the drop-down menu that displays.

	 b.	 Type Ctrl + X.

	 c.	 Select Cut icon from the Home tab.

	 2.	 Paste the data in the desired location.

To copy functions and formulas down a column or across a row using auto fill/drag and drop method

	 1.	 Highlight the cell with the formula to copy.

	 2.	 Put your mouse over the small square.

	 3.	 When you see the thin plus sign, drag and drop it to the entire cell range.
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Copying a Formula Using Auto Fill/Drag and Drop Method

Instructions :  In your class1.xls file :

	 1.	 Add a new heading entitled Numbers/10 to cell E4, using the same font : Century Gothic ; font style: 
bold and italics ; and font size : 11 as the other two headings.

	 2.	 Add the formula = D5/10 to cell E5.

	 3.	 Highlight cell E5.

	 4.	 Using Autofill, drop and drag the formula through cell E9.

	 5.	 When you have finished, return to the workbook and compare your work in MS Excel to the screen-
shots below.
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Adjust Column Width and Row Height

In some cases, you may want to change the width of a column or height of a row in order to adequately 
accommodate cell contents.

To adjust column width

	 1.	 Dragging the border :

	 a.	 Select the column you want to change.

	 b.	 Move your cursor to the border between two columns.

	 c.	 When you see the mouse symbol change to a vertical bar with arrows pointing both left and right, 
click and drag the column to the desired width.

	 2.	 Auto-fit column width to data :

	 a.	 Select the column you want to change.

	 b.	 Move your cursor to the border between two columns.

	 c.	 When you see the mouse symbol change to a vertical bar with arrows pointing both left and right, 
double-click.

	 3.	 Using right-click :

	 a.	 Select the column that you want to change by clicking on the corresponding letter at the top of 
the worksheet. To select multiple columns, continue to hold down the left mouse button and drag 
to select all columns you want change.

	 b.	 Right-click.

	 c.	 Select Column Width.

	 d.	 Type in a value.

	 e.	 Select OK.

To adjust row height

	 1.	 Select the row or rows that you would like to change.

	 2.	 Follow one of the first two procedures that are used to change column widths.

Insert or Delete Rows, Columns, and Cells
When working in MS Excel, you may encounter the need to insert or delete a row or column in your 
worksheet.
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To insert a row

	 1.	 Using the Home tab

�� Click on the row directly below where you would like the new row to display.

�� Click the Insert icon on the Home tab.

	 2.	 Using right-click

�� Click on the row directly below where you would like the new row to display.

�� Right click.

�� Select Insert.

To insert a column

	 1.	 Highlight the column directly to the right of where you would like the new column to display.

	 2.	 Next, either :

�� Right-click and choose Insert, or

�� Click the Insert icon on the Home tab

To delete a row or column

	 1.	 Select the row(s) or column(s) that you would like to delete.

	 2.	 Right-click and select Delete, or

	 3.	 Click the Delete icon on the Home tab.

 
If you select a single cell to delete instead of a whole column or row, a small box will display asking 
you if you would like to shift cells up or down, or whether you would like to delete an entire row or 
entire column. Choose accordingly, to execute the deletion.
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Merge Contents of Multiple Cells Together
MS-Excel also allows you to merge multiple adjacent cells together. When you merge two or more ad-
jacent cells, the cells become one merged cell, and the contents of the upper-left cell are displayed in 
the center of the merged cell. If there was any information stored in the other cells that you merged, 
these entries would be deleted.

To merge cells

	 1.	 Select the cells that you want to merge.
	 2.	 On the Home tab, click the Merge and Center icon. 

Sort Data
Sorting data is another useful feature available in MS-Excel. It allows you to arrange your worksheet data 
into a particular order, such as ascending or descending. It is always a good idea to save a new copy of 
your file before you begin sorting.

Using the class1.xls file, let’s learn how to sort.

To sort using the Data tab

	 1.	 On the Data tab, select the Sort icon.

A pop-up box will display with options for sorting.
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	 2.	 On the upper-right hand corner of the Sort pop-up box, check the box next to My data has headers.

	 3.	 Then in the Sort By drop-down menu, select Column D Header : Numbers.

	 4.	 Next in the Order drops-down menu, select Largest to Smallest and then click OK.

	 5.	 Note that the order of the numbers has changed; they are now sorted from largest to smallest.

To sort using the Sort buttons

	 1.	 Click on a cell in the column you would like to sort by.

	 2.	 On the Home tab, click the Sort & Filter button.
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	 3.	 From the drop-down menu, select Sort Largest to Smallest since we want the data to be sorted in 
descending order

 

To sort by multiple criteria

Sorting by multiple criteria can help you manage and find the data you need when working with a large 
worksheet. This option allows you to tell MS Excel what criteria to sort by first and how you would 
like to further sort that data.

	 1.	 Select the Sort icon from the Data tab. The Sort box will display.

	 2.	 As we did before, select how you want to initially sort the data in the “Sort by” section using the drop 
down menus under Column, Sort On, and Order.
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	 3.	 To sort by multiple criteria, simply click the Add Level and add another column which will then  
appear labeled “Then by”

	 4.	 Now select the next column to sort by in the “Then by” section.

Your data will now be sorted by one variable, and within each value of the first variable, it will be 
sorted by the second variable. This is especially helpful if you have things like names separated into two 
columns, and you would like to sort by last names and then by first names.

Let’s look at an example.

	 1.	 Highlight the data you would like to sort.

	 2.	 On the Data tab, select Sort.
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	 3.	 Once the Sort box opens :

	 a.	 If the data you have selected has a header row, make sure to select Header row in the My data 
range has section.

	 b.	 Select the column you want to first sort by in the Sort by drop-down menu, in this case Risk 
Factors. Sorting by Descending order (Z to A) places the “Y” (those with risk factors) before the “N” 
(those without risk factors).

	 c.	 Then select the column you want to next sort by in the Then by drop-down menu, in this case 
Gender

	 4.	 Click the OK button.

�� Note :		 the change in order. In the Risk Factors Column, all the Ys and Ns are grouped together. In the 
Gender column, females and males are grouped separately within each Risk Factors group.

LESSON-5



70 MANNUAL FOR COMPUTER APPLICATION

To sort one or more columns without affecting others (USE WITH CAUTION)

Occasionally, you may encounter a situation when you would like to sort one or more columns in your 
worksheet without changing the order in other columns. You must be very careful using this feature, 
since it can produce unwanted results such as mixing up records.

To sort one column (or a section of columns) :

	 1.	 Click on the column headings of the columns that you want to sort.

	 2.	 On the Data tab, select Sort.

	 3.	 Once the Sort box opens, choose the column you want to sort by and whether you want to sort in 
ascending or descending order.

	 4.	 Indicate whether your data have a header row. Click OK.

A Sort Warning box will display to ask whether we want to sort all associated data in the spreadsheet 
or just the cells selected.

	 5.	 Click Continue with the current selection, then click Sort. 

Preparing a Worksheet for Printing
You can use Print Preview to see how your page will print. Let’s look at class1.xls in the Print Preview 
mode. 
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Print Preview

To access this mode :

	 1.	 Go to the Office button
	 2.	 In the drop-down menu, select Print and then Print Preview

When viewing your file in Print Preview, click on the Page Setup button to use the Page Setup feature 
in order to customize print features, such as headers, footers, page orientation and size.

You can also insert a standard and/or custom header or footer into your worksheet. The headers and 
footers that you specify will automatically display on every printed page.
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To insert a header or footer :

	 1.	 Click on the Header/Footer tab in Page Setup box.

	 2.	 Select a standard header or footer (e.g., date, page number) from the drop down menu labeled header 
or footer or

	 3.	 Create your own custom header or footer by clicking on the Custom Header or Custom Footer buttons.

Once you are done with the page setup, click the OK button. To print your worksheet, click the Print 
button.

To exit the Print Preview without printing, click the Close Print Preview button.

You can also access the Page Setup menu while editing data without accessing Print through the Office 
button. Go to the Page Layout tab and select the small arrow in the bottom left corner of the Page Setup 
section.



73MANNUAL FOR COMPUTER APPLICATION

Print Titles
MS-Excel also has a function referred to as Print titles. If a worksheet spans more than one page, using 
the Print titles function allows you to print row and column headings or labels on every page of the 
worksheet to ensure that the data contained within the worksheet are properly labeled.

To insert Print titles :

	 1.	 Click the Page Layout tab and click on the Print Titles icon.

	 2.	 Go to the Sheet tab.

	 3.	 Next to the “Rows to repeat at top” box and “Columns to repeat at left” box, you will find an icon.

	 4.	 When you click on this icon, you are able to select the headings from the rows or columns of your 
worksheet that you would like to repeat on each page.
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On the Sheet tab, you can also choose to print gridlines by checking the box labeled Gridlines in the 
Print area. You can also select a specific area to print by clicking on the icon next to the “Print area” 
box and selecting the cells you want to print and Layout.

Class  1

Box and seelecting the cells you want to print.

Print and Layout
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Prepare worksheet for printing
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